QMS® 2001
Knowledge System
Setup Guide

1800324-001C



1)
N S

Introduction

This document explains how to set up the QMS 2001 Knowl-
edge System, an integrated information management system
for Windows environments. The 2001 incorporates scanning,
copying, faxing, data transmission, and laser printing.

Note: Ifyou have any difficulty installing the QM S 2001 Knowledge
System, contact QMS Customer Technical Assurance (CTA) for
assistance. See “Getting Help” on page 22 for more information.
Also, as with any device, if you're attaching the 2001 to a network,
you should have your system administrator help you. Improper
configuration could result in software or hardware conflicts.

Products Covered by this Setup Guide

The setup information in this guide covers two versions of the
QMS 2001 Knowledge System:

The QMS 2001 Knowledge
System peripheral unit is
designed to be attached to
an existing computer. This
model ships with scanning,
copying, faxing, and print-
ing capabilities. (It can be
upgraded to an integrated
486 computer system, like
the Knowledge System PC,
described below.) See “If you're installing a Knowledge Sys-
tem peripheral unit...” on page 2 for peripheral-unit installa-
tion steps.
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QMS 2001 Knowledge System
peripheral unit

The QMS 2001 Knowledge
System PC integrates all
the capabilities of the
peripheral unit with a built-
in 486 computer. The video
monitor, the keyboard, and
=, the mouse all connect
directly to the 2001. You
can purchase a pre-assem-
bled unit, or you can also
create your own by purchasing the peripheral unit (described
above), the expanded function kit, and your own computer
components. (Your QMS vendor has details.) See “If you're
installing a Knowledge System PC unit...” on page 2 for
installation steps.

QMS 2001 Knowledge System FC
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Installation Procedures

If you're installing a Knowledge System
peripheral unit...

Follow the instructions in this guide to...

m  Make sure your other hardware and software meet the
minimum recommended requirements (see page 3).

m  Unpack the system and check shipment contents (see
page 3).

Find a good location to set up the system (see page 4).
Install the PCU (see page 5).

Install the toner cartridge (see page 7).

Install the media trays (see page 8).

Install the fax modem in your computer (see page 9).

Connect the 2001 to your computer, a phone line, and a
power source (see page 12).

Install the QMS Manager software (see page 13).
m  Register and test the system (see page 17).

If you're installing a Knowledge System PC
unit...

Follow the instructions in this guide to...

®  Unpack the system and check shipment contents (see
page 3).

Find a good location to set up the system (see page 4).
Install the PCU (see page 5).

Install the toner cartridge (see page 7).

Install the media trays (see page 8).

Connect the 2001 to a phone line and a power source
(see page 12).

m  Register and test the system (see page 17).

If you're building your own Knowledge
System PC unit...

®  Unpack the system and check shipment contents (see
page 3).

m  Follow the instructions in the manual titled QMS 2001
Knowledge System PC Functional Expansion Instruc-
tions, included with the expanded function kit (available
from your QMS vendor). The Functional Expansion
Instructions manual will refer to this Setup Guide at
times.
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Minimum System Requirements for the
2001 Peripheral Unit

You'll need at least the following levels of hardware and soft-
ware installed to use the Knowledge System peripheral unit
(the Knowledge System PC comes with all necessary hard-
ware and software):

A 386 or higher computer with one free 16-bit slot, and a
parallel port that supports bi-directional communication

4 MB RAM

A hard disk with at least 7 MB of free space

DOS 5.0 or higher

Microsoft Windows 3.1 or higher

A 3.5" floppy disk drive

VGA monitor or better

Mouse

Analog telephone line

(This means use a standard phone line, not a digital line.)

Unpacking the 2001

Save the packing materials in case you ever need to ship or
move the 2001.

& WARNING! The 2001 engine weighs 48 Ibs/21 kg. Do not attempt
to lift it by yourself.

ACHTUNG! Das Gerét hat ein Gewicht von 21 kg. Bitte versuchen
Sie niemals, das Gerdte alleine anzuheben oder zu transportieren.

1

Open the main shipping carton and remove the
accessories tray.

Caution: Do not lift the 2001 from the front (the end where
the control panel is), as this could damage the manual-feed
tray or the toner-cartridge access door. Lift it from the sides
only.

Remove the 2001 from the carton, and place it on a
sturdy, level surface.

Remove the packing materials, the protective bag,
and any tape from the 2001.
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What's Included in the Shipment

If you're missing anything, report it to your QMS vendor.

All Knowledge Systems come with...

QMS 2001 Knowledge System engine
Photoconductor unit (PCU)

Toner cartridge

Media cassette (letter or A4 size)
Output tray

Fax modem board with telephone cable and documenta-
tion (included only in units sold in the US, and only if
ordered)

Bi-directional parallel cable (included, but not needed for
the QMS 2001 Knowledge System PC)

Power cord
QMS Manager software disks
QMS 2001 Knowledge System Quick Reference manual

QMS 2001 Knowledge System Setup Guide (this docu-
ment)

Knowledge System PCs also come with...

If you purchased a Knowledge System PC, you should have
the items listed above, plus the following:

Keyboard

Mouse

DOS disks and documentation
Windows disks and documentation

Manufacturers’ documentation for the monitor and the
single-board computer

Monitor with a power cord and interface cable (shipped in
a second box).
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Location Requirements

The QMS 2001 Knowledge System should be located...

Away from cooling sources, heating sources,
extreme temperature changes, and direct sunlight...

Away from excessive dust, corrosive chemicals or
vapors, any strong electromagnetic field (such as
that created by an air conditioner), and excessive
vibration...

On a level surface (within .08"/2 mm from front to
rear and left to right) capable of supporting 48 Ib/21
kg...

So there is enough space for users to access all
sides of the system. (The 2001 measures 27.6"/702
mm wide by 26.9"/684 mm deep.)

Installing the Photoconductor Unit

22

Caution: The belt inside the PCU is sensitive to bright light and
scratches. Don’t remove the PCU from its protective bag until you
are ready to install it, and then hold it only by the handles as
shown in step 3.

Open the printer cover.
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Remove the PCU from its packaging and remove the
red tab (and attached piece of polystyrene) at each
end of the PCU.

Holding the PCU by its two handles (one on each
end), slide it into the system. An arrow on each han-
dle identifies which side goes in first.

Grasp the green dot on the black light-shield paper,
and pull it out of the unit.

Close the printer cover, making sure both sides are
securely shut.
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Installing the Toner Cartridge

1 Remove the toner cartridge from its packaging.

23] Caution: Don't touch the roller inside the toner cartridge.

2 Holding the cartridge by the ends, gently shake it a
few times to distribute the toner.

3 Pull out the toner seal at one end of the cartridge,
and discard the seal.

To avoid spilling toner, keep the toner cartridge upright (as
shown) after removing the toner seal.

4 Open the toner-cartridge access door.
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Push the toner cartridge firmly in place.

Close the toner-cartridge access door.

Installing the Media Trays

1

3

Remove any tape or packing materials from the
media cassette.

Open the cassette cover and place media in the cas-
sette printing-side down, with the top edge of the
media going into the 2001 first.

Cassette Cover Keep media under these brackets

Keep media

Metal plate (at bottom
under these

of tray) should be
pressed down

Close the cassette cover, and then slide the cassette
firmly into the system.
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Unfold the scanner-tray extension and slide the
scanner-tray flaps (under the tray) together.

Scanner-Tray
Flaps

Install the output tray: set the two tabs on the bottom
of the tray into their slots as shown below.

Output Tray

If you have a Knowledge System peripheral unit, con-
tinue with “Installing the Fax Modem in the Com-
puter” below. If you have a Knowledge System PC,
skip to “Connecting the Knowledge System PC” on
page 18. If you are connecting a Knowledge System
to a computer that already has a fax modem

installed, skip to “Connecting the Knowledge System
Peripheral Unit” on page 12

Installing the Fax Modem in the Computer

This procedure requires you to install a circuit board in your com-
puter and possibly to change some computer settings, so you'll
need to refer to your computer’s documentation for some informa-
tion. If you feel uncomfortable about performing these procedures,
you might want to get an experienced person to help you.

1

Use Microsoft Diagnostics (MSD) to find out which
COM settings are in use on your computer: Exit Win-
dows (if necessary) and at the DOS C:\ prompt, type
msd, press Enter, and then choose the COM Ports but-
ton in the screen that appears.
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2 In the COM Ports screen, see which COM settings are
in use (unused ports are labeled N/A). In the table
below, circle the cell in the left-most column that
lists all the COM settings in use in your computer.

3 Check the fax modem’s documentation (included
with the fax modem) to find out what its default COM
port setting is. In the table below, circle this setting
in the top row.

4 Find the cell located where the row and the column
you marked intersect. This cell tells you what COM
setting to configure the fax modem to use. (See the
fax modem documentation for instructions on chang-
ing the COM setting if necessary.)

If this And the fax modem is set to...

setting is

already

7 G COM 1 COM 2 COM 3 COM 4

COM 1only Reset the fax | Leave the fax | Reset the fax | Leave the fax
modemto2 |modemsetto|modemto2 |modemsetto
or 4. 2. or 4. 4.

COM 2 only Leave the fax | Reset the fax | Leave the fax | Reset the fax
modem set to | modemtolor | modemset to | modemto1or
1. 3. 3. 3.

COM 3 only | Reset the fax | Leave the fax | Reset the fax | Leave the fax
modemto2 |modemsetto|modemto2 |modemsetto
or 4. or 4.

COM 4 only Leave the fax | Reset the fax | Leave the fax | Reset the fax
modem set to | modemto1or | modemset to | modemto1or
1. 3. 3. 3.

COM 2 & 4 Leave the fax | Reset the fax | Leave the fax | Reset the fax
modem set to | modemtolor | modemsetto | modemtolor
1. 3. 3. 3.

COM1&3 Reset the fax | Leave the fax | Reset the fax | Leave the fax
modemto2 |modemsetto|modemto2 |modemsetto
or 4. 2. or 4. 4,

COM1&2 You have to do one of the following:

or mif one of these COM settings is being used by an exter-
nal serial port that is not connected to anything (for

COM1& 4 example, often COM 1 and 2 are used by two serial ports
on the back of the computer, and the COM 1 port is used

or by a mouse or a printer but the COM 2 port isn’t con-
nected to anything), you can disable the unconnected

COM2&3 port and then use the COM setting that was assigned
to it for the fax modem). See your computer documenta-

or tion for information on disabling ports and reassigning

COM B &4 COM settings.
uIf the fax modem and the computer support the use of

or non-standard IRQs (interrupt requsetasjfor COM set-
tings, you can set up the fax modem to use one of the

More than unused COM ports with a non-standard IRQ. See the fax

two COM set | modem and computer documentation for information on

tings using non-standard IRQs.
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More information about COM settings is provided on
page 23. You should also check your fax modem
documentation for any instructions specific to your
particular fax modem.

5 Turn off the computer and disconnect the power cord
and any other cables.

Caution: As with any procedure involving microcircuitry,
you should take steps to eliminate static electricity, which
can destroy circuit boards such as the fax modem. It's
best to use an anti-static wristband (available from your
computer vendor) for this. Otherwise, you can discharge
static by touching any unpainted metal surface on a grounded
(plugged-in) appliance. In addition, handle circuit boards by
their edges only, and avoid walking around, especially on car-
pet, while working with them.

6 Remove the cover from the computer and locate an
open 16-bit slot (approximately 6" long) on the com-
puter’s motherboard. (See your computer documen-
tation for information.)

7 Remove the spacer plate for that slot from the com-
puter’s interface panel by removing the screw hold-

ing it in place.
5 These illustrations are provided
pacer as examples: your computer's
Plate

slots may be oriented differently.

16-Bit Slog

8 Remove the fax modem from its anti-static bag.
(Save the bag in case you need to ship or store the
board.)
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Fit the fax modem’s retaining bracket into the com-
puter’s interface panel and press the fax modem
firmly into the 16-bit slot.

Inside PC

Fasten the fax modem’s retaining bracket to the com-

puter’s interface panel with the screw you removed
earlier.

Make sure none of the computer’s components have
shifted or loosened during the procedure.

Replace the system unit cover on the computer and

re-attach the power cord and the other cables to the
computer.

Connecting the Knowledge System
Peripheral Unit

Bi-directional ’
Power Switch
Farallel Port Power Socket

(<]
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Using the parallel cable provided, connect the

Knowledge System’s parallel port to the computer’s
LPT1 port.

Caution : We strongly recommend using the QM S-provided
cable, because it is designed for the high-speed bi-directional
parallel communication required by the 2001. Using a differ-
ent cable could cause communication errors or prevent oper-
ation altogether.
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2 At the computer, use the telephone cable (included
with the fax modem) to connect the jack labeled
“Line” on the fax modem to a phone jack in the wall
(where you would normally plug in your phone). If
the fax modem jacks aren’t labeled, see the fax
modem documentation to see which one you should
connect to the wall jack.

3 If you want to use the same telephone line to make
voice calls when the fax modem is not in use, plug
your phone (or another analog device, such as an
answering machine) into the second jack on the fax
modem.

The Fax Server is set up to answer the line on the first ring,
but if you use the same line for faxing and voice calls, you'll
probably want the Fax Server to wait a few more rings before
answering. You can change this setting in the Preferences
dialog box (choose Preferences from the Options menu in
QMS Manager when you start it for the first time). Choose the
Help button for information on options in that dialog box.

4 Connect the 2001 to a grounded electrical outlet.

Make sure the electrical outlet you connect the system to is a
properly grounded (earth connection) outlet, running 120
VAC, 50-60 Hz (if you have a 110V unit), or 230 +10 VAC, 50
Hz (if you have a 220V unit). The system should be directly
connected to an outlet.

5 Turn on the 2001. When the Ready light stops blink-
ing, the system is ready to use.

Installing the Knowledge System Software

R Caution : We recommend that you make backup copies of all of
the disks, store the originals in a safe place, and use the copies to
install the software. One way to do this is to open the Windows File
Manager and choose Copy Disk from the Disk menu. Choose Help
in the dialog box that appears for more information.

Installing the QMS Manager Software

Note: You cannot install the software by copying files from
the disks. You must run the setup program.

1  With Windows running, insert Disk 1 of the Knowl-
edge System software in a 3.5" disk drive at the com-
puter.
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From the Program Manager File menu choose Run.
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In the Run dialog box, type a:setup

(If the disk is in another drive, substitute the letter of that
drive for a, for example, b:\setup  .)
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Choose OK and follow the instructions that appear
on the screen. A few notes on installation:

For users of the Adobe Type Manager (ATM) pro-
gram, Setup places several new PostScript fonts in
the QMS2001 directory: Akcidens, Clarendon
Medium, and Couria. See your ATM documentation
for information on installing and using PostScript
fonts. (For TrueType font users, TrueType versions
of Akcidens and Clarendon are installed also.)

Any ATM or TrueType font can be used with QMS
Manager, but these fonts were developed especially
for fax legibility.

The setup program allows you to choose whether
the Fax Server (the program which allows you to
send and receive faxes) starts automatically when
Windows starts. If you choose Yes, the Fax Server
icon will be placed in the StartUp program group. (If
you later decide you don’t want the Fax Server to
start automatically, you can remove it from the Start-
Up Group).
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Note: If the Fax Server is not running when QMS Manager is
started, then QMS Manager startup will be delayed for 15 to
30 seconds while the Fax Server is initialized.

B The product registration information you are asked
to provide is saved in a file that you can later fax to
QMS to register and test the system. The software
version number is on the disk labels.

When installation is complete, exit Windows, restart
the computer, then restart Windows.

If, during Setup, you chose to let QMS Manager auto-
matically load the Fax Server when Windows starts,
then QMS Manager will look for the fax modem and
present the Auto Setup dialog box. In the Modem
Type list, select your fax modem (if you purchased a
fax modem from QMS, select the QMS/Zoom FaxMo-
dem option). Choose OK, then go to step 7.
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If, during Setup, you chose not to let QMS Manager
automatically load the Fax Server, then the first time you
use QMS Manager, the Auto Detect dialog box appears
as QMS Manager looks for the modem and determines its
type. Select your fax modem from the Modem Type list. If
you purchased a fax modem from QMS, choose the QMS/
Zoom FaxModem option. Choose OK.

In the QMS 2001 Program Group, double-click the
What's New icon in the QMS 2001 Knowledge System
program group to see any last-minute update infor-
mation.

If you ever need to install more options or reinstall the
software, double-click the QMS Manager Setup icon in
the QMS 2001 Knowledge System program group and
follow the instructions that appear.

If you ever need to uninstall the Knowledge System
software, see the “Troubleshooting” section of the QMS
2001 Quick Reference for instructions.
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Activate the Printer Driver
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In Windows, double-click the Control Panel icon
(usually in the Main program group).

In the Control Panel window, double-click the Printers
icon.

Select QMS-2001 in the Installed Printers area.
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Choose the Set As Default Printer button.

The Print Manager checkbox can be selected or
deselected: the 2001 doesn’t use Print Manager.

Choose the Setup button. In the Setup dialog box,
choose the print settings you want. (Choose Help for
more information on these options.)
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Choose OK to exit the Setup dialog box, choose
Close to exit the Printers dialog box, then close the
Control Panel window by double-clicking the control
box in the upper-left corner.
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Register and Test the System

Register your 2001 and try out the system at the same time
by faxing the registration document to QMS:

1 In QMS Manager, from the Window menu, choose
Document Storage.

2 In the Document Storage window, select REGCARD.
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3 Choose the Send button on the button bar.

In the Send Document dialog box, select QMS Regis-
tration Card in the Phone List box.

5 Choose the Add button to add QMS Registration
Card to the Send To list.

6 In the Dialing Prefix text box, if necessary, type 9 (or
whatever prefix you must normally dial to get an out-
side line) followed by a comma. The comma makes
the modem pause long enough for the outside-line
dial tone.

If you're going to need a dialing prefix (such as 9, ) for most
of your faxes, you can have QMS Manager add it for you.
Choose Prefer-ences from the Options menu in QMS
Manager, then type the prefix in the Dialing Prefix text box
and select the Use Dialing Prefix checkbox. Choose the Help
button for more information on options in that dialog box.

7 Choose OK to send the REGCARD information to our
toll-free number.

8 Skip to “Where To Go From Here” on page 20.
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Connecting the Knowledge System PC

% Mouse Port Monitor Port Power Switch
\ L
® \ ® ®
Phone B °
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Parallel (Thactive Port) Power Socket
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R Caution : Before connecting the system, make sure it’s off.

1

Use the telephone cable included with the fax modem
to connect the jack labeled “Line” on the fax modem
to a phone jack in the wall (where you would nor-
mally plug in your phone). If the fax modem jacks
aren’t labeled, see the fax modem documentation to
see which jack you should connect to the wall jack.

If you want to use the same telephone line to make voice
calls when the fax modem is not in use, plug your phone
(or another analog device, such as an answering
machine) into the second jack on the fax modem.

Note: The Fax Server is set up to answer the line on the first
ring, but if you use the same line for faxing and voice calls,
you'll probably want the Fax Server to wait a few more rings
before answering. You can change this setting in the
Preferences dialog box (choose Preferences from the
Options menu in QMS Manager when you start it for the first
time). Choose the Help button for information on options in
that dialog box.

Connect the monitor and the mouse at the back of
the system.

Connect the keyboard to the round connector on the
front of the 2001 (under the floppy disk drive).

Power

Monitor

Keyboard Connector

Keyboard
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Connect the 2001 to a grounded electrical outlet.

Note: Make sure the electrical outlet you connect the system
to is a properly grounded (earth connection) outlet, running
120 VAC, 50-60 Hz (if you have a 110V unit), or 230 10 VAC,
50 Hz (if you have a 220V unit). The system should be
directly connected to an outlet.

Connect the monitor to a grounded electrical outlet
and turn it on.

Turn on the 2001. When the Ready light stops blink-
ing, the system is ready to use.

(When you're ready to shut down the system, turn off the
monitor first, then the 2001.)

QMS 2001 Knowledge System PC
Electronic Registration

1

With Windows running, in Program Manager double-
click the QMS 2001 Knowledge System program
group icon to open it (if it's not already open).

In the QMS 2001 Knowledge System program group,
double-click the Registration icon to open the Regis-
tration dialog box.

Enter the information requested in the Registration
dialog box. The software version number is on the
disks shipped with your system.

If the QMS 2001 Fax Server icon appears anywhere
on your Windows desktop, close it by clicking on it
once and then selecting Close from the menu that
appears.

In the QMS 2001 Knowledge System program group,
double-click the QMS Manager icon to start QMS
Manager (if it's not already started).

In QMS Manager, choose Document Storage from the
Window menu.
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In the Document Storage list, select REGCARD.

If REGCARD does not appear in the Document Storage
window, make sure you followed the instructions in step
4, above.
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8 Choose Send from the QMS Manager button bar to
open the Send Document dialog box.

9 In the Send Document dialog box, select QMS Regis-
tration Card from the Phone List.

10 Choose the Add button to add QMS Registration
Card to the Send To list.

11 In the Dialing Prefix text box, if necessary, type 9 (or
whatever prefix you normally have to dial to get an
outside line) followed by a comma. The comma
makes the modem pause long enough for the out-
side-line dial tone.

Note: If you're going to need a dialing prefix (such as 9, ) for
most of your faxes, you can have QMS Manager add it for
you. Choose Prefer-ences from the Options menu in QMS
Manager, then type the prefix in the Dialing Prefix text box
and select the Use Dialing Prefix checkbox. Choose the
Help button for more information on options in that dialog box.

12 Choose OK to send your registration information to
our toll-free number.

13 In the QMS 2001 Program Group, double-click the
What's New icon in the QMS 2001 Knowledge System
program group to see any last-minute update infor-
mation.

If you ever need to reinstall the software, double-click the
QMS Manager Setup icon in the QMS 2001 Knowledge
System program group and follow the instructions that
appeatr.

If you ever need to uninstall the Knowledge System
software, see the “Troubleshooting” section of the QMS
2001 Quick Reference for instructions.

Where To Go From Here

For information on using the QMS 2001
Knowledge System...

QMS 2001 Knowledge System Quick Reference Guide —
This manual contains abbreviated instructions for the most
commonly used faxing, printing, copying, scanning, and data-
transfer procedures.

QMS Manager on-line help —This is the most detailed source
of information on the QMS 2001 Knowledge System. Choose
an option from the Help menu, choose the Help button in a
dialog box, or double-click the 2001 Help icon in the QMS
2001 Knowledge System program group to access the on-line
help. If you've never used Windows help before, choose How
to Use Help from the Help menu in the Help window.
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For information on DOS and Windows...

MS DOS and Microsoft Windows documentation —Using the
QMS Manager software is easy, but like any Windows appli-
cation it requires some basic Windows skills. If you're not
familiar with Windows, please take some time to review its
documentation before using the QMS Manager software.
(Completing the Windows Tutorial is a great way to learn the
basics: Choose Windows Tutorial from the Help menu in
Program Manager .) If you've never used a computer before,
it's also a good idea to review the introductory sections of the
DOS documentation.

For information on the fax modem, the
monitor, or the 486 board...

See the manufacturer’s documentation shipped with the sys-
tem.

For information on consumables, service,
or other products...

In the US, call QMS at (800) 777-7782 for consumables
(toner, PCUs, print media), (800) 858-1597 for service, or
(800) 631-2692/2696 for information on QMS products. In
other countries, see “QMS World-wide Offices” on page 23 for
telephone numbers.
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If You Have Trouble...

If you have difficulties setting up the 2001, try the following:

1 Make sure interface cables and power cords are
secure.

2 Make sure the other hardware and software meet the
minimum requirements listed in “Minimum System
Requirements for the 2001 Peripheral Unit” on page 3
of this guide.

3 Review the setup procedure, making sure you fol-
lowed all the steps necessary for your version of the
product. (See “Products Covered by this Setup
Guide” on page 1 for more information.)

If you still can’t resolve the problem, see “Getting Help” to find
out how to contact us.

Getting Help

In the US, QMS Customer Technical Assurance (CTA) is
available from 7 am to 6 pm, Central Time, at (205) 633-
4500*. You can also fax questions to CTA at (205) 633-3716.
Please indicate whether you would like a reply by fax or by
phone. In other countries, refer to the “QMS World-wide
Offices” section for the telephone number of the QMS office
closest to you.

If you call for assistance, have the following information ready
so our technicians can help you more quickly:

®  Your phone number, fax number, and shipping address

m A description of the problem

®  The name of your system (QMS 2001 Knowledge System
or QMS 2001 Knowledge System PC)

®  The amount of RAM installed on your 2001 and your com-
puter

m  If the 2001 is connected to an external computer, the
make and model of the computer

m  The versions of QMS Manager, DOS, and Windows
you're using

m  The make and model of your fax board

] Th(}e1 specific application and version you're having trouble
Wit

m  The contents of your CONFIG.SYS file and your
AUTOEXEC.BAT file

®  The contents of your WIN.INI and SYSTEM.INI files (in

the Windows subdirectory)

*The 205 area code changes to 334 on January 15, 1995.
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QMS World-wide Offices

®  United States/Latin America
One Magnum Pass
Mobile, AL 36618
(205) 633-4300*
Fax (205) 633-4866*
Latin America Fax (205) 639-3347*

m  Canada
Saint-Laurent, Québec
(514) 333-5940 or (800) 361-3392
Fax (514) 333-5949
National Service Fax (905) 673-7676

m  Europe, Middle East, Africa
Dusseldorf (49) 211/596 1333
London (44) 784 430900
Maarssen (31) 3465 51 333
Paris (33) (1) 4107 9393
Stockholm (46) (8) 725 5680

®m  QMS Asia-Pacific
Auckland 64 (9) 630 7912
Melbourne 61 (3) 899 5777
Sydney 61 (2) 901 3235
Tokyo (81) 3-3437-4030

More Information about COM Settings

Because of the way MS-DOS and computer hardware are
designed, any time you attach or install a serial device (like a
fax-modem board) you have to figure out which COM setting
to configure the new device for. (“COM” is the name MS-DOS
uses for serial communication ports.) Each serial device must
have a unique COM setting, one that isn’t used by anything
else in the computer.

But most likely, one or more of the four COM settings MS-
DOS provides (COM 1, COM 2, COM 3, and COM 4) was
already assigned to something in your computer before it
even left the factory. (For example, any serial ports you see
on the back of your computer are probably using COM set-
tings, even if they’re not connected to anything.)

You also have to remember that, generally, you can only have
two COM settings in use at one time. COM 1 and COM 3 usu-
ally can’t both be in use at the same time, because normally
they're both set up to use the same IRQ setting (IRQ 4). The
same goes for COM 2 and COM 4, which share IRQ 3. (IRQ
stands for Interrupt ReQuest. Every device used by the com-
puter, whether it's a serial device or not, is assigned an IRQ.)
It is possible to use both 1 and 3 or both 2 and 4, ifthe new
serial device can be configured to use a “non-standard” IRQ
(an IRQ other than 3 or 4), and ifthis non-standard IRQ is not
assigned to anything else in the computer. (Check the serial
device documentation to find out if the device supports IRQs
other than 3 and 4. To find out if these non-standard IRQs are
available in your computer, you can use Microsoft Diagnos-

*The 205 area code changes to 334 on January 15, 1995.
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tics (MSD)—described in step 1 in “Installing the Fax Modem
in the Computer” on page 9. Unassigned IRQs are labeled
“Reserved” in MSD.)

If you currently have no serial devices attached to or installed
in your computer (or if you only have one device, like a serial
mouse or printer), then deciding which COM to use for the
new device is pretty simple: Just find out what the first avail-
able COM is and configure the device to use that.

But if you have more than one COM setting in use already,
you'll have to either disable one of them or use a third COM
setting with a non-standard IRQ.

For example, many PCs have two serial ports on the back,
which are assigned to COM 1 and COM 2. If you're not using
COM2, you could disable the port assigned to COM 2 and
configure the new serial device to use COM 2.

If you want to configure the new serial device to use a third

COM setting, you'll have to find out what non-standard IRQs
your device supports, then find out which of these IRQs are
unused in your computer, then assign the unused, non-stan-
dard IRQ to the COM setting you want to use.

See your computer documentation for information on COM
settings, IRQ settings, disabling serial ports, and installing
serial devices. See your serial device documentation for COM
configuration instructions and other installation information.

Trademarks

The following trademarks listed as registered are registered in
the United States Patent and Trademark Office. Some
trademarks may also be registered in the other countries.
Other product names mentioned in this manual may be
trademarks of registered trademarks of their respective
owners.

QMS® and the QMS logo/QMS, Inc.; Adobe Type Manager®
PostScript™ /Adobe Systems Incorporated; True Type® /Apple
Computer, Inc.; Windows™, Microsoft®, MS DOS® /Microsoft
Corporation; UltraFAX™, ZSoft™ /WordStar Atlanta
Technology Center, Inc., a wholly owned subsidiary of
WordStar International, Inc.
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Manual Notice

QMS, Inc. reserves the right to make changes to this manual
and to the equipment described herein without notice.
Considerable effort has been made to ensure that this manual
is free of inaccuracies and omissions. However, QMS, Inc.
makes no warranty of any kind including, but not limited to,
any implied warranties of merchantability and fitness for a
particular purpose with regard to this manual. QMS, Inc.
assumes no responsibility for, or liability for, errors contained
in this manual or for incidental, special, or consequential
damages arising out of the furnishing of this manual, or the
use of this manual in operating the equipment, or in
connection with the performance of the equipment when so
operated.

Copyright Notice

This manual is Copyrighted © 1994 by QMS, Inc., One
Magnum Pass, Mobile, AL 36618. All Rights Reserved. This
manual may not be copied in whole or in part, nor transferred
to any other media or language, without the express written
permission of QMS, Inc.

QMS PN 1800324-001C
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